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Foreword
This manual explains the functions and operations of DAQOPC. To ensure correct use,
please read this manual thoroughly before beginning operation. After reading the
manual, keep it in a convenient location for quick reference whenever a question arises
during operation.
DAQOPC is an OPC server that provides OPC interface (Data Access interface). The
OPC interface was designed by the OPC (OLE for Processing Control) Foundation.
This manual describes the specifications of the Data Access interface and venderspecific section. This manual is for those who understand the specifications of the OPC
Foundation.

Notes
• The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions.
• Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.
• Copying or reproducing all or any part of the contents of this manual without the
permission of Yokogawa Electric Corporation is strictly prohibited.

Copyright
• YOKOGAWA holds the copyright to the software that is on the CD-R.

Trademarks
• All the brands or names of Yokogawa Electric’s products used in this manual are
either trademarks or registered trademarks of Yokogawa Electric Corporation.
• Microsoft, MS-DOS, Windows, Windows 2000, and Windows NT are either registered
trademarks or trademarks of Microsoft Corporation in the United States and/or other
countries.
• Adobe and Adobe Acrobat are trademarks of Adobe Systems Incorporated (Adobe
Systems).
• Other company and product names are trademarks or registered trademarks of their
respective companies.
• For purposes of this manual, the  and  symbols do not accompany their respective
trademark names or registered trademark names.

Revisions
1st Edition
2nd Edition
3rd Edition
4th Edition
5th Edition

November 2000
September 2001
May 2002
November 2002
December 2005
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All Rights Reserved, Copyright © 2000 Yokogawa Electric Corporation
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Checking the Contents of the Package
Unpack the box and check the contents before operating the software. If some items are
missing or otherwise inconsistent with the contents description, please contact your
dealer or nearest YOKOGAWA representative.

Model and Suffix Code
Model

Basic Suffix Code

DXA410

Specification
DAQOPC OPC Server

-0

OS (Windows NT Workstation 4.0,NT Server 4.0,Windows
2000)
1
2
3
4

Basic Version, Japanese
Basic Version, English
Advanced Version, Japanese
Advanced Version, English

Package Contents
DXA410 DAQOPC
User's manual (this document)
DXA410 DAQOPC
Installation manual

ii

1 pc.

CD-R 1 pc.
(in case)

1 pc.
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Notes on Using This Product
Storing the CD-R
Please store the original CD-R in a safe place. During the actual operation, use the
software that is installed on the hard disk.

Agreement
Restriction on Use
Use of this product (this utility software and manual) by more than one computer at the
same time is prohibited. Use by more than one user is also prohibited.
Transfer and Lending
Transfer or lending of this product to any third party is prohibited.
Guarantee
Should a physical deficiency be found on the original CD-R or this manual upon opening
the product package, please promptly inform Yokogawa. The claim must be made within
seven days from the date you received the product in order to receive a replacement free
of charge.
Exemption from Responsibility
Yokogawa Electric Corporation provides no guarantees other than for physical
deficiencies found on the original CD-R or this manual upon opening the product
package. Yokogawa Electric Corporation shall not be held responsible by any party for
any losses or damage, direct or indirect, caused by the use or any unpredictable defect
of the product.
Copyright
YOKOGAWA holds the copyright to the software that is on the CD-R.
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CD-R Handling Guidelines
Make sure to take the following safety precautions.

Caution
• Do not store the product near large amounts of refuse or dust.
• Do not touch the side of the CD-R with no printed characters.
Dirt or sweat from fingertips can damage the CD-R. Do not write anything on the
CD-R.
• Pencil lead or residue from erasers can damage the CD-R.
• Do not bend or scratch the CD-R.
Doing so can cause it to become unreadable.
• Never place anything on top of the CD-R.
Doing so can cause deformities that can render the CD-R useless.
• Do not drop the CD-R from high locations.
Dropping the CD-R can cause damage or deformities.
• Do not place the CD-R in direct sunlight or near heat sources.
• When cleaning the CD-R, do not use solvents.
Especially do not use alcohol, benzene, or freon.
• Take care when placing the CD-R into the CD-ROM drive.
• While the CD-R is being accessed, do not remove the CD-R from the CD-ROM
drive, cut the power to the PC, or reset the computer.
• Store the CD-R in its original jewel case.
Do not leave the CD-R in the CD-ROM drive after use. It can become deformed
or damaged unless it is kept in its case.

iv
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Chapter 1 Overview

1.1

1

Functional Overview of DAQOPC

Overview

What Is an OPC Interface
By using the OPC interface provided by YOKOGAWA, the user is able to access various
data on the DX/DX-P/MV/CX via the DAQOPC server using an OPC-compliant
application that runs on a Windows machine. The user does not have to create a special
application program.
The OPC interface is a standard interface that uses OLE (Object Linking and
Embedding) for process control. It consists of a server that provides various data on the
DX/DX-P/MV/CX and a general-purpose interface used to access the server.
OPC applies OLE, which is a standard method of communication between applications
in the Windows environment, to process control. It allows the exchange of process data
between multiple general-purpose Windows applications.
Client

DAQOPC

DX/DX-P/MV/CX
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1.1 Functional Overview of DAQOPC

DAQOPC Functions
Functions Common to the Basic and Advanced Version
• Provides Data Access function (DA), the OPC interface.
DA function: Reading and writing of the current value of the process data that uses
ItemID as the data identifier.
• Starts and stops the OPC server in sync with the start and shutdown of Windows.
• Supports the communication interfaces of the DX/DX-P/MV/CX which includes
Ethernet, RS-232, and RS-422-A. The DX-P only supports the Ethernet interface.
• Allows a data update rate of up to 1 s. However, data update may not be possible at
the specified rate depending on the communication conditions.
When retrieving data other than items PV, SP, OUT, ALARM1-4, COMMON.STATUS,
and COMMON.PROP, the server issues a query command to the connected device.
If the client requests the retrieval of these items to the server, the data retrieval takes
time, and the load on the CPU on the server side PC increases.
• You can read measured values, computed values, control setting values (CX), alarm
statuses, and other values as item IDs.
• Capable of reading and writing communication input data as an ItemID (administrator level
only). However, for the DX-P, this is only for users using communication input data.
• Allows access using DX/DX-P/MV/CX administrator and user levels.
• By setting the communication status with the connected device to an ItemID, the client
is able to instruct a recovery after a power failure.
• Retrieves span value, unit, tag, alarm type, and alarm setpoint as Property IDs of the
ItemID.
• The DAQOPC OPC server supports the OPC Data Access Version1.0A and 2.0.
• The DAQOPC OPC server supports the OPC DA Custom Interface.
• The DAQOPC OPC server supports the OPC DA Automation Interface.
• The DAQOPC OPC server supports the optional OPC DA browser function.
(Browser function is used by the OPC client to browse the contents of the OPC server.)
• The DAQOPC OPC server can connect up to 24 DX/DX-P/MV/CXs.
Advanced Version Functions
You can write the following items. However, control loop and control computation
contstant items can only be written on the CX. Also, some items are not supported by
certain styles of CX.
Accessing the DX-P with the Advanced version is the same as that with the Basic
version since the monitor function (port number 34261) is used.
* Supported by style 2 of the CX or later.
** Supported by style 3 of the CX or later. When PV/SP computation is ON, you cannot write
the measured value 1 input bias, measured value 2 input bias, measured value 1 input
filter, measured value 2 input filter, or remote input filter.

Alarm setpoint
Recording start/stop
Computation start/stop
Batch name (with the batch option only)
Lot number (with the batch option only)
Writing messages (with the batch option only)
Output value of internal loops (only internal loops)
Run/Stop of internal loops *
Control mode of internal loops *
Switching Remote/Local on internal loops *
Current SPNo. of internal loops *
(See next page.)
1-2
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1
Overview

SP settings for each PID of the of internal loops
Alarm setpoint for each PID of the of internal loops
Proportional band (P) settings for each PID of the of internal loops
Integral time (I) settings for each PID of the of internal loops
Derivative time (D) settings for each PID of the of internal loops
Output high-limit for each PID of the of internal loops
Output low-limit for each PID of the of internal loops
Manual reset value for each PID of the of internal loops
Preset output value for each PID of the of internal loops
Control direction settings for each PID of the of internal loops
ON/OFF control hysteresis setting for each PID of the of internal loops
Measured value 1 input bias of the control loop **
Measured value 2 input bias of the control loop **
Remote input bias of the control loop **
Measured value 1 input filter of the control loop **
Measured value 2 input filter of the control loop **
Remote input filter of the control loop **
Control loop ratio setting **
Control computation constants **

Where OPC Interface Fits
OPC client refers to the application that requests data using the OPC interface. OPC
server refers to the application that provides the data.
General-purpose PC
Windows 2000
Windows XP
OPC client

OPC interface

General-purpose PC

Ethernet

General-purpose PC

OPC client

OPC interface
OPC server
(DAQOPC)

OPC server
(DAQOPC)

Ethernet

DX/DX-P/MV/CX

DX/DX-P/MV/CX

Process data

Process data

The OPC server and OPC client run on a general-purpose PC.
You can use a commercially sold OPC-compliant application or an OPC-compliant
application that you’ve created using VC++ (Visual C++), VB (Visual Basic), or VBA
(Visual Basic for Application) as an OPC client.
IM 04L01B03-61E
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Server/Client Configuration
The DAQOPC user (OPC client) may exist on the same PC as the DAQOPC server or
on a host computer (Windows machine).
When the OPC client exists on the same PC as the DAQOPC server

OPC client
OPC interface
OPC server
(DAQOPC)

Process data

Ethernet

• Application size:
• Performance:

Mid-size
Faster than when the OPC client exists on a host computer,
because a local OPC server is used.

When the OPC client exists on a host computer
Application
PC

OPC interface
OPC client

Process data
Ethernet

OPC server
(DAQOPC)

OPC server
(DAQOPC)
Ethernet

• Application size:
• Performance:

1-4

Ethernet

Mid- to large-size
The performance degrades slightly (20% to 30%) per server
when compared to when the OPC client exists on the same
PC as the DAQOPC server. This is because the DCOM
(Distributed Component Object Model) is used to connect
between the client and server.
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Hardware Requirements

Overview

The following hardware is required for DAQOPC to operate properly.
• PC model:
IBM PC/AT compatible (that can run Windows 2000 or
Windows NT)
• CPU:
Pentium 300 MHz or later (Windows 2000)
Pentium 800 MHz or later (Windows XP)
• Main memory:
256 MB or more
• Free disk space:
1 GB or more.
• Communication device: RS-232 port supported by the OS.
Ethernet NIC (not required if the OPC client and the DAQOPC
server exist on the same PC, and the RS-232/RS-422-A
interface is used to retrieve data from the DX/MV/CX.)
• Peripheral devices:
Mouse supported by the OS.

Software Requirements
The following software is required for DAQOPC to operate properly.
• OS:
Windows 2000 or Windows XP Professional.
The language version of the package (DAQOPC) must be the same
(both Japanese or both English) as that of the operating system
(Windows 2000 or Windows XP.)
• Service pack: Windows 2000 SP 3, 4.
Windows XP Proffesional SP1, 2

Miscellaneous
If the communication interface with the DAQSTATION is RS-422-A, an RS-232/RS-422A converter is required.
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1.2

Overall Configuration and DAQOPC Interface
This section will describe the overall construction of DAQOPC and an overview of
DAQOPC functions.

Overall Construction of DAQOPC
The overall construction of DAQOPC is shown below. DAQOPC OPC server consists of
a server that provides the interface specifications of the OPC DA.

OPC client
Automation
Wrapper

DAQOPC DA server

OPC interface
Process data
Engineering data

DX/DX-P/MV/CX

Role of each function
An overview of the interface that DAQOPC supports is indicated.
Process Data

OPC Specification

Complies with DA2.0
Current value data
Read/write*
* With the Advanced version, you can save the items shown on page 1-2.

OPC Specification

Engineering Data

1-6

Tag information

Load

Complies with DA2.0

Tag list

Load

Complies with DA2.0
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Server Function

Overview

A list of DAQOPC server functions is shown below.
Function Name

Description

OPC DA custom interface

Functions that complies with the custom
interface of the OPC specification.

OPC DA automation interface

Functions that complies with the automation
interface of the OPC specification.

DA Server
Application capacity
The application capacity of the DAQOPC DA server is shown below.
Item

Application Capacity

Maximum number of clients

100 clients

Maximum number of group objects
Maximum number of registered ItemIDs

1,000 groups
10,000/group

Maximum number of cache update ItemIDs
Cache update rate (UpdateRate)

100,000
1,000 to 3,600,000 ms (1 s to 1 h)

Server name (ProgID)
Server name is as follows:
Server Name: Yokogawa.ExaopcDADAQOPC1

Note
You can also check the server name (ProgID) in the Version Information dialog box of the
DAQOPC configuration window.
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OPC Custom Interface and OPC Automation Interface
The OPC specification defines two types of interfaces: OPC custom interface and OPC
automation interface. Both of these interfaces have approximately the same data access
functions, but they are designed for different client programs.
The DAQOPC OPC server implements both interfaces and supports both types of client
programs.
Custom Interface
Application

Automation Interface

For dedicated applications such as
For easy access from script languages
SCADA/MES/analysis software programs

Number of client languages VC++

Visual Basic

Performance

Poor

Good

The OPC custom interface uses the basic OLE/COM functions directly and operates at a
high speed.
In contrast, the OPC automation interface complies with the OLE automation interface
that allows access from Visual Basic. The process that facilitates the access from script
languages leads to an overhead, and, therefore, the performance is slightly lower than
the OPC custom interface.
VB and VC++ versions
If you are creating an application program (OPC client), use the following versions of
VB and VC++.
Version

DAQOPC and User Application on the DAQOPC and User Application on
Same PC
Different PCs.

DAQOPC R3.01

VB6.0, VC++6.0 (SP5)

VB5.0/6.0, VC++5.0/6.0

If you are creating a program using VB, select the Yokogawa Exaopc Data Access
Automation Server check box by choosing Project > References.

1-8
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2.1

Flow of DAQOPC Operation
This section will describe the operations of DAQOPC. For the access method from the
OPC client software, see chapter 3, “DAQOPC DA Server Function.”
DAQOPC refers to the setup file at startup and logs onto the DX/DX-P/MV/CX. The
DAQOPC configuration window provides easy-to-use user interface (like a typical
Windows application) for displaying and setting the communication parameters of the
DX/DX-P/MV/CX from which DAQOPC is to retrieve data. In addition, the DAQOPC
configuration window shows information that is required for the client to connect to
DAQOPC (ProgID).

2
DAQOPC Operation

Flow of Operation
The general flow of operation is as follows:
1. Determine the method of connection with the DAQSTATION from which to retrieve
the data using the Configurator.
2. Start DAQOPC.
3. Set up the client software if the client is on a different PC.

Changing the Parameter during DAQOPC Operation
You can change system parameters on the DAQOPC configuration window even when
DAQOPC is in operation. However, the specified parameters take effect the next time
DAQOPC is started.

IM 04L01B03-61E
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2.2

Starting the Configurator and Setting
Parameters

Configurator
Configurator is used to set the communication conditions between DAQOPC and the
DAQSTATION from which to retrieve the data.

Starting the Configurator
Choose Start > Programs > DAQOPC > DAQOPC Configurator. The window that
appears when the program is started is shown below.

2-2
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A List of Menu Commands
The functions of menu commands are indicated below.
File > Revert
Reloads the setup file without saving the information that you are currently editing.
File > Save
Saves the information that you are currently editing to the setup file.
File > Print
Prints the recorder settings and serial settings that you are currently editing.
File > Print Preview
Prints the preview of the recorder settings and serial settings that you are currently
editing.
File > Printer Setup
Sets the printer.
File > Exit
Exits the Configurator.
Settings > Working Condition
Displays the Working Condition dialog box.
Settings > Ethernet Setting
Displays the Ethernet Setting dialog box.
View > Recorder Setting
Switches to the Recorder Setting tab.
View > Serial Setting
Switches to the Serial Setting tab.
View > Toolbar
Shows or hides the toolbar.
View > Status Bar
Shows or hides the status bar.
Help > About
Displays the Version Information dialog box.

DAQOPC Operation
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Working Condition Dialog Box
Set the following items on the Working Condition dialog box.

• Time Stamp
Select whether to use the time of the connected recorder or the time of the PC in
which DAQOPC is installed for the time stamp that is added when the data is
retrieved.

Note
If daylight savings time is engaged on the main DX/DX-P/MV/CX and the time changes from
summer to winter, loaded data will not be correctly updated on other connected units if they
are not synched to the main device. Therefore you should select Use time of PC in such
cases.

• Execute by simulation mode
If you select this check box, DAQOPC does not perform communications with the DX/
DX-P/MV/CX and operates as a simulator.
• How to treat special data
Assigns values to special data that is retrieved from the DX/DX-P/MV/CX. For values
over or under the range, you can specify a particular value or assign upper and lower
limits of the span. You can also assign values for skip, error, and unstable data value.
You can assign a value between -100000000 and 1000000000. A decimal point is
added to the appropriate position to the value that is actually retrieved.
In addition, you can assign a value when a nonexistent channel is specified as an
item. The selectable range is -100000000 to 1000000000.
• How to treat data at communication error
Specify the handling of the value when an error occurs while data is being retrieved.
If the previous value is used, the value before the communication error is retrieved. If
you are specifying a particular value, it is handled in the same fashion as “How to treat
special values.” If a communication error occurs when DAQOPC initially connects to
the DX/DX-P/MV/CX, the value is always set to 0.
2-4
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Setting of Ethernet Setting Dialog Box
Set the following items on the Ethernet Setting dialog box.

2
DAQOPC Operation

• Use Time-out
Select this check box when setting a timeout.
• Start and Connect
Set the timeout time and the retry count for establishing connection at the startup of
the server. These values also apply to the reestablishment of the connection when 2
is written to Common.Status. You can set 1 ms to 60000 ms for Time-out. You can
set 0 to 10 times for Retry. When connection is established, retry is stopped before
the specified count is reached. If Retry is set to 0 and the connection fails, the
communication fails and the connection is not retried.
• Time-out for communication
Select this check box to set the timeout for the communication error when retrieving
data or requesting write operation after connection. You can set 1 ms to 60000 ms for
Time-out.
• Auto retry function
Select this check box to reestablish the connection when retrieving the next data or
requesting the next data write operation when communication failed or communication error
occurred. The settings for Time-out and Retry are the same as those for Start and Connect.

Note
With the DX-P if the password is incorrect, neither automatic recovery nor manual recovery
through writing to the item STATUS is allowed. Please make note of this. Also, it is
recommended that the password expiration period for users connected to the DX-P be set to
when the DX-P main unit is turned OFF.

IM 04L01B03-61E

2-5

2.2 Starting the Configurator and Setting Parameters

Configuring the Recorder
The Recorder Setting tab page is shown below.

The following items are specified on the Recorder Setting tab page.
Make sure to set the Model, Port, and Address when connecting to the DX/DX-P/MV/CX.
Model:
Select the type of DX/DX-P/MV/CX to be connected.
Port:
Select the port to be connected. For COM, only the ports that are valid
in the serial settings are displayed.
Address:
Only the COM ports that are set to Ethernet or RS-422-A are valid.
(Note: The DX-P can only select Ethernet. )
Meas. Ch:
Select the number of measurement channels of the DX/DX-P/MV/CX to
be connected.
Math Ch:
Select the number of computation channels of the DX/DX-P/MV/CX to
be connected.
Int. Loop:
Select the number of internal loop of the CX to be connected.
PID NO:
Select the number of PID of the CX to be connected.
Ext. Loop:
Select the number of external loop of the CX to be connected.

Note
The values of measurement channels, computation channels, internal loops, PID group
numbers, and external loops are retrieved from the DX/DX-P/MV/CX when connecting to it,
so there is no need to enter those values. However, in simulation mode, DAQOPC operates
according to the values set here, since it does not communicate with the DX/DX-P/MV/CX.

When the port is an Ethernet port
Click the address to display the following dialog box.

2-6

IM 04L01B03-61E

2.2 Starting the Configurator and Setting Parameters

Note
•
•

•

With the CX and DX, if the login level is user, communication input data cannot be specified
as an DAQOPC item ID.
With the DX-P, the monitor function is used (port number: 34261) Therefore, the write
function cannot be used. However, communication input data can be written if using a user
specified as “users using communication input data” on the DX-P side.
With the DX-P if the password is incorrect, neither automatic recovery nor manual recovery
through writing to the item STATUS is allowed. Please make note of this. Also, it is
recommended that the password expiration period for users connected to the DX-P be set to
when the DX-P main unit is turned OFF.

When the port is COM
Click the address to display the following dialog box.

Set the RS-422-A address.

Serial Setting Tab Page
The following items are specified on the Serial Setting tab page.

Port No.:
Type:
Baud Rate:
Parity Bit:
Stop Bit:
IM 04L01B03-61E

Select the check box corresponding to the port to be used.
Set the type of port to be used.
Select the baud rate for the port to be used.
Set the parity for the port to be used.
Select the stop bit for the port to be used.
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Specify the following parameters.
IP Address or Host name:
Enter the IP address or host name that is assigned to
the DX/DX-P/MV/CX that is to be connected.
Login name:
Specify the login name.
User ID:
Specify the user ID. (DX-P only)
Password:
Specify the password.
Login level:
Specify the level for the specified login name. (Other
than DX-P)
If the parameters are not correct, connection to the DX/DX-P/MV
/CX fails.

2.2 Starting the Configurator and Setting Parameters

Version Information Dialog Box
The Version Information dialog box shows the following information.
• Version information
• ProgID
• Serial number
Basic Version

Advanced Version

2-8
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2.3

Starting and Stopping DAQOPC
Starting DAQOPC
The DA server process automatically starts as a background process when the
Windows system is started. At this point, DAQOPC starts communications with the
DAQSTATION according to the communication conditions that were specified using
the Configurator.
Stopping DAQOPC
The DA server process automatically stops when the Windows system is shut down.

DAQOPC Operation
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2.4

Setting Up the DAQOPC Client
If you are using DAQOPC remotely from a PC that is connected to the network, you must
setup the DAQOPC client.
If you have not set up the DAQOPC client, follow the procedure below to set up the
software.
1. Insert a formatted floppy disk into the floppy drive of the PC (PC server) in which you
have installed DAQOPC.
2. On the server PC, run ZOPMKEXAFDC.exe in the Program folder in the installation
folder of the DAQOPC using a program such as Windows Explorer.
3. A dialog box appears when an OPC client setup disk is created.
Click OK in the dialog box.
4. Log on to the PC (PC client) in which to setup the OPC client
using a user name
belonging to the Administrator group.
5. Insert the setup floppy disk that you have just created into the floppy drive of the client
PC.
6. Run Setup.exe on the setup floppy disk. The OPC client is set up.

OPC server

ZOPMKEXAFDC.exe

Setup.exe
PC

DAQOPC

Access Method from the Client Software
The ProgID used in accessing DAQOPC from the client software is as follows:
Yokogawa.ExaopcDADAQOPC1

2-10
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3.1

Overview of the DAQOPC DA Server Function

Data Access Method via the OPC Interface
Through the OPC Interface, the OPC client creates a group object in the server object
and registers the process data to be accessed as an ItemID in the group object. ItemIDs
are registered in the form “tag, tag item.” Using this scheme, you can specify the data
acquisition rate for each group object. You can also register the same ItemID in different
group objects according to your application.

3
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Server object
Group object A

Group object B

ItemID1

ItemID3

ItemID1

ItemID3

ItemID2

ItemID4

ItemID2

ItemID4

In the example below, two group objects, Trend 1 and Report 1, are created in the server
object A. Device1!ch01.PV through ch04.PV are registered as ItemIDs in the Trend 1
group object. Device1!ch01.PV and Device1!ch01.Alarm1 are registered as ItemIDs in
the Report 1 group object.
Trend 1 and Report 1 are accessed as independent group objects. In addition, the value
of Device1!ch01.PV exists in Trend 1 and Report 1 in this example.
(Server object)
Server object A

(Group object)
Trend 1

(ItemID)
Device1!ch01.pv
Device1!ch02.pv
Device1!ch03.pv
Device1!ch04.pv

Report 1

Device1!ch01.pv
Device1!ch01.Alarm1

OPC Interface Compliance
The DAQOPC is an OPC server that provides the interface complying with the following
OPC DA Specification Version 2.0 and Version 1.0A.
• OPC DA Custom Interface
• OPC DA Automation Interface
It supports all the standard functions that are defined in these OPC Specifications.
In addition, those items that are defined as options (browse function of items) are also
supported.

Note
For details on the OPC Custom Interface and OPC Automation Interface, see the
corresponding sections in section 1.3, “Server Functions.”
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OPC Interface Functions
The DAQOPC supports the standard interface of OPC Version 2.0. It also supports a
portion of the interface that is defined to be options. For clients that use the older
version of the OPC interface, functions that were supported in OPC Version 1.0A are
also supported.
This section will mainly focus on the vender-specific option interface of the DAQOPC.
For details on the OPC Interface, see the specifications that are released by the OPC
Foundation.

3.2.1 A List of Interfaces
A list of interfaces that are supported is indicated for the OPC Custom Interface and
OPC Automation Interface.
Custom Interface
The table below indicates whether or not the DAQOPC supports various interfaces of
the Custom Interface.
Object
OPCServer

OPCGroup

EnumOPCItem
Attributes

Interface Name

Description

Support

IOPCServer

A standard interface of the OPC DA server
Adds and Deletes group objects

Yes

IOPCCommon

OPC common interface
Sets the locale and retrieves error strings

Yes

IConnectionPointContainer OPC common interface
Interface for asynchronous communication used
to notify the client that the server is going to shut
down

Yes

IOPCItemProperties

Yes

Interface Retrieves the properties of the ItemID

IOPCBrowseServerAddress Browses the ItemIDs in the OPC DA server
Space(optional)

Yes

IOPCServerPublicGroups
(optional)

Connects to the public group; deletes the public
group

No

IPersistFile
(optional)

Loads and saves configuration information

No

IOPCGroupStateMgt

Manages the group object

Yes

IOPCItemMgt

Manages the ItemIDs

Yes

IOPCSyncIO

Performs synchronous write and read operations

Yes

IOPCAsyncIO2

Performs asynchronous write and read operations

Yes

IConnectionPointContainer Interface for creating connections for
asynchronous read and write operations

Yes

IOPCPublicGroupStateMgt
(optional)

Convert a private group to a public group

No

IOPCAsyncIO (old)

Performs asynchronous write and read operations
(old interface for compatibility)

Yes

IDataObject (old)

Performs connection and disconnection to the
asynchronous I/O (old interface for compatibility)

Yes

IEnumOPCItemAttributes

Retrieves a list of ItemIDs that are registered in the
group object

Yes

Yes: Supported, No: Not supported
3-2
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Automation Interface
The DAQOPC only supports the automation interfaces that correspond to the custom
interfaces that are supported. The table below shows whether or not the interface is
supported. (Since those that are not supported may result in error, error handling for
Visual Basic must be provided.)

Object

Type

OPCServer

Methods

Events

Description

Support

StartTime

Time when the server was started

Yes

CurrentTime

Current time

Yes

LastUpdateTime

Time that was notified last

Yes

MajorVersion

Major version

Yes

MinorVersion

Minor version

Yes

BuildNumber

Build number

Yes

VendorInfo

Vendor information

Yes

ServerState

Server state

Yes

LocaleID

Locale ID

Yes

Bandwidth

Bandwidth

Yes

OPCGroups

Collection of group objects

Yes

PublicGroupNames

Public group name

No

ServerName

Server name

Yes

ServerNode

Node name

Yes

ClientName

Client name

Yes

GetOPCServers

Gets a list of server names

Yes

Connect

Established connection

Yes

DisConnect

Releases connection

Yes

CreateBrowser

Creates a browser object

Yes

GetErrorString

Gets the error string

Yes

QueryAvailbleLocaleIDs

Gets a list of supported locale IDs

Yes

QueryAvailableProperties

Gets a list of properties

Yes

GetItemProperties

Gets properties

Yes

LookupItemIDs

Converts the ItemID of properties

No

ServerShutDown

Shutdown event

Yes

Yes: Supported, No: Not supported
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Properties

Name

3.2 OPC Interface Functions
Object

Type

Properties

OPCBrowser

Methods

Properties

OPCGroups

Methods

Name

Description

Support

Organization

Hierarchical type

Yes

Filter

Filter specification

Yes

DataType

Data type

Yes

AccessRights

Access rights

Yes

CurrentPosition

Current position

Yes

Count

Number of collections

Yes

Item

Gets the object

Yes

ShowBranches

Gets a list of current positions

Yes

ShowLeafs

Gets a list of current positions

Yes

MoveUp

Moves the hierarchy

Yes

MoveToRoot

Moves the hierarchy

Yes

MoveDown

Moves the hierarchy

Yes

MoveTo

Gets the absolute position

Yes

GetItemID

Gets the ItemID

Yes

GetAccessPaths

Gets access paths

Yes

DefaultGroupIsActive

Default active property

Yes

DefaultGroupUpdateRate

Default cache update

Yes

DefaultGroupDeadband

Default deadband

Yes

DefaultGroupLocaleID

Default locale ID

Yes

DefualtGroupTimeBias

Default time bias

Yes

Count

Number of collections

Yes

Item

Gets the group object

Yes

Add

Adds a group

Yes

GetOPCGroup

Gets the group object

Yes

Remove

Deletes the group

Yes

RemoveAll

Deletes all groups

Yes

ConnectPublicGroup

Gets the public group

No

RemovePublicGroup

Deletes the public group

No

Yes: Supported, No: Not supported
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Object

Type

Properties

Description

Support

Name

Group name

Yes

IsPublic

Public property (always FALSE)

No

IsActive

Active property

Yes

IsSubcscribed

Asynchronous property

Yes

ClientHandle

Client handle

Yes

ServerHandle

Server handle

Yes

LocaleID

Locale ID

Yes

TimeBias

Time bias

Yes

DeadBand

Deadband

Yes

UpdateRate

Cache update rate

Yes

OPCItems

Item collection

Yes

SyncRead

Performs a synchronous read

Yes

SyncWrite

Performs a synchronous write

Yes

AsyncRead

Performs an asynchronous read

Yes

AsyncWrite

Performs an asynchronous write

Yes

AsyncRefresh

Refreshes

Yes

AsyncCancel

Cancels asynchronous request

Yes

DataChange

Change notification

Yes

AsyncReadComplete

Asynchronous read response

Yes

AsyncWriteComplete

Asynchronous write response

Yes

AsyncCancelComplete

Cancel response

Yes

3
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OPCGroup

Name

Methods

Events

Yes: Supported, No: Not supported

IM 04L01B03-61E

3-5

3.2 OPC Interface Functions
Object

Type

Properties

Name

Description

Parent

Parent group object

Yes

DefaultRequestedDataType

Default requested data type

Yes

DefaultAccessPath

Default access path

No

DefaultActive

Default active property

Yes

Count

Number of collections

Yes

Item

Gets the item object

Yes

GetOPCItem

Gets the item object

Yes

Remove

Removes the item object

Yes

Validate

Checks the item

Yes

SetActive

Sets the active property

Yes

SetClientHandles

Sets the client handle

Yes

SetDataTypes

Sets the data type

Yes

AddItem

Adds an item

Yes

AddItems

Adds multiple items

Yes

Parent

Parent group object

Yes

ClientHandle

Client handle

Yes

ServerHandle

Server handle

Yes

AccessPath

Access path

No

AccessRights

Access rights

Yes

ItemID

ItemID

Yes

IsActive

Active property

Yes

RequestedDataType

Requested data type

Yes

Value

Data value

Yes

Quality

Quality flag

Yes

TimeStamp

Time stamp

Yes

CanonicalDataType

Data type assigned by the server

Yes

EUType

Engineering unit type

No

EUInfo

Engineering unit information

No

Read

Performs a synchronous read

Yes

Write

Performs a synchronous write

Yes

Support

OPCItems

Methods

Properties
OPCItem

Methods

Yes: Supported, No: Not supported
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3.2.2 Process Data
The process data of the OPC specification consists of the following three elements.
• Value
• Quality Flag
• Time Stamp
Value
OPC uses a data type called VARIANT.

3
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Quality Flag
This flag indicates whether the Value was retrieved correctly. Notifies the reason if
erroneous.
The quality flag of DAQOPC follows the system of the OPC specifications. The
quality flag system of the OPC specifications consists of the following three contents.
• Quality (Good, Bad, or Uncertain)
• Substatus (details dependent on the Quality)
• Limit (additional information for the substatus)
The quality flag is expressed using the following 8 bits.
Substatus on the Quality code

7

6

5

4

3

2

1

0
Bit

Limit
(Not Limited/LL/HL/Constant)
Quality (Good, Bad, or Uncertain)

DAQOPC sets these three types of information as a quality flag.
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Quality and Substatus
The Substatus of the Quality code contains information that can be expressed using 4
bits for each Quality (Good, Bad, and Uncertain). The Substatus codes are defined
by the OPC specifications. DAQOPC uses these codes to add details. The table
below shows the information that the OPC specifications define.

Substatus for Each Data Quality Code
Code
Good(3)

Bad(0)

Uncertain(1)

0

Non-specific

Non-specific

Non-specific

1

N/A

Configuration Error Last Usable Value

2

Local Override

Not Connected

N/A

3

Device Failure

Sensor Not Accurate

4

Sensor Failure

EngineeringUnitsExceeded

5

Last Known Value

Sub-Normal

6

Comm Failure

7

Out of Service

8
9
10
11
12
13
14
15

Limit
Limit is yet another Quality code information that is added to the combination of
Quality and Substatus.
Code

3-8

Description

0

Not Limited

1

Low Limited

2

High Limited

3

Constant
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Data and Quality code
The data from the DX/DX-P/MV/CX is converted to the following Quality codes.
Quality

Substatus

Limit

Normal value

Good

Non-specific

Not Limited

Positive overrange value

Good

Non-specific

High Limited

Negative overrange value Good

Non-specific

Low Limited

Skip or computation Off

Bad

Out of Service

Not Limited

Error value

Bad

Sensor Failure

Not Limited

Unstable data value

Bad

Out of Service

Not Limited

Communication error

Bad

Comm Failure

Not Limited

Quality

Phenomenon
The specified tag does not exist
when re-reading the attribute
information or the tag never existed

Bad

Substatus

3
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Data status

Limit

Configuration Error Not Limited

By assigning values other than normal values using the Configurator, you can check
the data from the DX/DX-P/MV/CX even without the Quality code.
Time Stamp
Retrieves either the time of the DX/DX-P/DX-P/MV/CX or the time of the PC. Using
the Configurator, you can change the destination from which to retrieve the time.
Selection on the Configurator

Description

Time of the device (DX/MV/CX) Retrieves the time of the device *
Time of the PC

Retrieves the time of the PC in which the
server for retrieving the data is installed in UTC †

* Several commands are issued when data is retrieved. The time of the data registered in the
group corresponds to the time of the device that is retrieved by the first command issued.
Therefore, the time of the device may not be applied correctly depending on the item.
† Several commands are issued when data is retrieved. The time of the PC corresponds to
the time when all the items registered in the group are retrieved.
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3.2.3 ItemID
An arbitrary string used to identify items. It is generally called tags.

Defining the ItemID
DAQOPC defines ItemIDs as follows:
Device!tag number.data item
Example: DEVICE1!CH001.PV
The “DEVICE” section is fixed. In the number section that follows, specify the
device position that you assigned using the Configurator.

A list of ItemIDs
On DAQOPC, the following items can be accessed using ItemIDs.
ItemID

Description

Canonical Access
data type Rights

DEVICExx!CHxxx.PV

Measured value or computed result

VT_R8

Read Only Measurement and
computation channels only

DEVICExx!CHxxx.ALARMx

Alarm status of the specified
channel

VT_I2

Read Only Measurement and
computation channels only

DEVICExx!CHxxx.ATx

Alarm type of the specified channel

VT_I2

Read Only Measurement and
computation channels only

DEVICExx!CHxxx.ASPx

VT_R8

DEVICExx!Loopx.PV

Alarm setpoint of the specified
channel
PV of the specified loop

Read/Write2 Measurement and
computation channels only
Read Only
CX control loops only

DEVICExx!Loopx.SP

SP of the specified loop

VT_R8

Read Only

CX control loops only

DEVICExx!Loopx.OUT

OUT of the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!Loopx.ALARMx

Alarm status of the specified loop

VT_I2

Read Only

CX control loops only

DEVICExx!Loopx.ATx

Alarm type of the specified loop

VT_I2

Read Only

CX control loops only

DEVICExx!Loopx.RUN1

Run/Stop switching of the specified
loop

VT_I2

Read/Write2

CX control loops only

DEVICExx!Loopx.MODE1

Control mode switching of
the specified loop

VT_I2

Read/Write2

CX control loops only

DEVICExx!Loopx.REMLOC1

Remote/Local switching of
the specified loop

VT_I2

Read/Write2

CX control loops only

DEVICExx!Loopx.SPNO1

Current SP number of the specified
loop and switching of the number

VT_I2

Read/Write2

CX control loops only

DEVICExx!Loopx.PIDNO1

Current PID number of the specified
loop

VT_I2

Read Only

CX control loops only

DEVICExx!Loopx.PID-SP

SP of the specified PID of
the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-ASPx

Alarm setpoint of the specified PID
of the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-P

Proportional band of the specified
PID of the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-I

Integral time of the specified PID
of the specified loop

VT_I2

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-D

Derivative time of the specified PID
of the specified loop

VT_I2

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-OH

Output high-limit of the specified
PID of the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-OL

Output low-limit of the specified PID
of the specified loop

VT_R8

Read/Write2

CX control loops only

1,2
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Notes

With the Advanced version, data can only be written to the DX/MV/CX if a user with Administrator privilages is logged
on. Data cannot be written to the DX/MV/CX with the Basic version.
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ItemID

Description

Canonical Access
data type Rights

DEVICExx!Loopx.PID-MR

Manual reset value of the specified
PID of the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-PO

Preset output value of the specified
PID of the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-DR

Control direction setting of
VT_I2
the specified PID of the specified loop

Read/Write2

CX control loops only

DEVICExx!Loopx.PID-H

Hysteresis setting of the ON/OFF
control of the specified PID of
the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!LoopZ.BS1

Measured value 1 input bias of the
specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!LoopZ.BS2

Measured value 2 input bias of the
specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!LoopZ.RBS

Remote input bias of the specified
loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!LoopZ.FL1

Measured value 1 Input filter of the
specified loop

VT_I2

Read/Write2

CX control loops only

DEVICExx!LoopZ.FL2

Measured value 1 Input filter of the
specified loop

VT_I2

Read/Write2

CX control loops only

DEVICExx!LoopZ.RFL

Remote input filter of the specified
loop

VT_I2

Read/Write2

CX control loops only

DEVICExx!LoopZ.RT

Ratio setting of the specified loop

VT_R8

Read/Write2

CX control loops only

DEVICExx!EXTxx.PV

PV of the specified external loop

VT_R8

Read Only

CX external loops only

DEVICExx!EXTxx.SP

SP of the specified external loop

VT_R8

Read Only

CX external loops only

DEVICExx!EXTxx.OUT

OUT of the specified external loop

VT_R8

Read Only

CX external loops only

DEVICExx!EXTxx.Alarmx

Alarm status of the specified
external loop

VT-I2

Read Only

CX external loops only

DEVICExx!CHcxx.INPUT

Value of the communication input
data

VT_R8

Read/Write3

Communication input data
only

DEVICExx!Wbb.VALUE

Control computation constants

VT-R8

Read/Write2

CX only

DEVICExx!COMMON.STATUS Device status

VT_I2

Read/Write

DEVICExx!COMMON.PROP

VT_I2

Read/Write

DEVICExx!COMMON.Record Device sampling status
4

Read/Write2

DEVICExx!COMMON.Math

Device computation status

Read/Write2

DEVICExx!Batch.Name5

Device batch name

Read/Write2

DEVICExx!Batch.LotNo.

Device lot number

Read/Write2

DEVICExx!Message!Direct.

Device message writing

Read/Write2

5

1
2
3

4
5

3
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Property read status

Notes

Other than DX-P

Applies only to CX Style2 or later
With the Advanced version, data can only be written to the DX/MV/CX if a user with Administrator privilages is logged
on. Data cannot be written to the DX/MV/CX with the Basic version.
With the Basic and Advanced versions, data can only be written to the DX/MV/CX if a user with Administrator-level
privileges is logged on. With the DX-P, writing is only possible when logged on as a user specified as a “user using
communication input data.”
Valid with the MATH option.
Valid with the DX-P or DX/CX batch option.
XX: The device position set using the Configurator.
YYY: Measurement and computation channel numbers. 001 to 060.
a:
Alarm number. 1 to 4.
bb:
Control computation constant number. 1 to 36.
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Item IDs
When reading
• If nonexistent channels or loop PID numbers are specified in the items, the value is 0.
• Except for item PV, SP, or OUT, the previous value is held if a communication error
occurs.
When Writing
• No check is performed on the server side to determine whether or not the value to
write is within the allowed range.
• Item name PV
Specifiable tag:
Measurement, computation, control loop, external loop
The communication error values, +OVER values, -OVER values, skip values, error
values, and unstable data values are set to the values specified in the Configurator.
If control mode is OFF on the CX, or for analog retransmission, it is set to the skip
value.
• Item name ALARM
Specifiable tag:
Measurement, computation channels, control loops, and
external loops
Item names are ALARM1, ALARM2, ALARM3, and ALARM4.
The alarm value is 0 if there is no alarm occurring. Otherwise the value is set
according to the list below.
Alarm type
0: Alarm OFF
1: Upper limit alarm
2: Lower limit alarm
3: Difference upper limit alarm
4: Difference lower limit alarm
5: Upper limit on rate-of-change alarm
6: Lower limit on rate-of-change alarm
7: Delay upper limit alarm
8: Delay lower limit alarm
21: PV high-limit alarm

22:
23:
24:
25:
26:
27:
28:
29:
30:
31:

PV low-limit alarm
Deviation high-limit alarm
Deviation low-limit alarm
Deviation high & low limit alarm
Deviation within high & low limit alarm
SP high-limit alarm
SP low-limit alarm
Output high-limit alarm
Output low limit alarm
Other alarms

For skip channels or channels with MATH turned OFF, or when control mode is OFF or
the analog retransmission loop is specified, the value is 0 when alarms are turned OFF.
• Item name AT
Specifiable tag:
Measurement, computation channels, and control loops
Item names are AT1, AT2, AT3, and AT4.
Same as “Item name ALARM.”
For skip channels or channels with MATH turned OFF, or when control mode is OFF or
the analog retransmission loop is specified, the value is 0 when alarms are turned OFF.
• Item name ASP
Specifiable tag: Measurement and computation channels
Item names are ASP1, ASP2, ASP3, and ASP4.
For skip channels or channels with MATH turned OFF, or when control mode is OFF or
the analog retransmission loop is specified, the value is 0 when alarms are turned OFF.
• Item name SP (CX only)
Specifiable tag: Control loops and external loops
The communication error values, +OVER values, -OVER values, skip values, error
values, and unstable data values are set to the values specified in the Configurator. If
control mode is OFF on the CX, or for analog retransmission, it is set to the skip
value.
3-12
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• Item name OUT (CX only)
Specifiable tag: Control loops and external loops
The communication error values, +OVER values, -OVER values, skip values, error
values, and unstable data values are set to the values specified in the Configurator. If
control mode is OFF on the CX, it is set to the skip value.
Data can only be written with a CX Style2 or later.
• Item name RUN (CX of style number S2 or later only)
Specifiable tag: Control loops
1
2

DAQOPC DA Server Functions

Stop:
Run:

3

If control mode is OFF or if the analog retransmission loop is specified, the value is 0.
• Item name MODE (CX of style number S2 or later only)
Specifiable tag: Control loops
Auto:
1
Manual: 2
Cascade: 3

If control mode is OFF or if the analog retransmission loop is specified, the value is 0.
• Item name REMLOC (CX of style number S2 or later only)
Specifiable tag: Control loops
Local:
1
Remote: 2

If control mode is OFF or if the analog retransmission loops or loops on which remote
input selection is turned OFF are specified, the value is 0.
• Item name SPNO (CX of style number S2 or later only)
Specifiable tag: Control loops
If control mode is OFF or if the analog retransmission loop is specified, the value is 0.
• Item name PIDNO (CX of style number S2 or later only)
Specifiable tag: Control loops
If control mode is OFF or if the analog retransmission loop is specified, the value is 0.
• Item name BS1 (CX of style number S3 or later only)
Specifiable tag: Control loops
The value is 0 if the measured value 1 input bias cannot be set, or if control mode is
OFF or analog retransmission loops are specified, or if the measured value 1 input
bias setting is OFF.
If the measured value 1 input bias is OFF when writing and a value other than 0 is
input, it automatically turns ON. However, even if 0 is entered, you cannot turn it
OFF.
• Item name BS2 (CX of style number S3 or later only)
Specifiable tag: Control loops
The value is 0 if the measured value 2 input bias cannot be set, or if control mode is
OFF or analog retransmission loops are specified, or if the measured value 2 input
bias setting is OFF.
If the measured value 2 input bias is OFF when writing and a value other than 0 is
input, it automatically turns ON. However, even if 0 is entered, you cannot turn it
OFF.

IM 04L01B03-61E

3-13

3.2 OPC Interface Functions
• Item name RBS (CX of style number S3 or later only)
Specifiable tag: Control loops
The value is 0 if the remote input bias cannot be set, or if control mode is OFF or
analog retransmission loops are specified, or if the remote input bias setting is OFF.
If the remote input bias is OFF when writing and a value other than 0 is input, it
automatically turns ON. However, even if 0 is entered, you cannot turn it OFF.
• Item name FL1 (CX of style number S3 or later only)
Specifiable tag: Control loops
The value is 0 if the measured value 1 input filter cannot be set, or if control mode is
OFF or analog retransmission loops are specified, or if the measured value 1 input
filter setting is OFF.
If the measured value 1 input filter is OFF when writing and a value other than 0 is input,
it automatically turns ON. However, even if 0 is entered, you cannot turn it OFF.
• Item name FL2 (CX of style number S3 or later only)
Specifiable tag: Control loops
The value is 0 if the measured value 2 input filter cannot be set, or if control mode is
OFF or analog retransmission loops are specified, or if the measured value 2 input
filter setting is OFF.
If the measured value 2 input filter is OFF when writing and a value other than 0 is
input, it automatically turns ON. However, even if 0 is entered, you cannot turn it OFF.
• Item name RFL (CX of style number S3 or later only)
Specifiable tag: Control loops
The value is 0 if the remote input filter cannot be set, or if control mode is OFF or
analog retransmission loops are specified, or if the remote input filter setting is OFF.
If the remote input filter is OFF when writing and a value other than 0 is input, it
automatically turns ON. However, even if 0 is entered, you cannot turn it OFF.
• Item name RT (CX of style number S3 or later only)
Specifiable tag: Control loops
If the ratio setting cannot be set, or control mode is OFF or if the analog
retransmission loop is specified, the value is 0.
When the ratio setting is OFF, when writing a value other than 1, it automatically turns
ON. You cannot set it to OFF.

Note
For the number of digits to the right of the RT decimal point, the number when reading RT
from the instrument is applied. This number of digits is also used when writing. Therefore,
remember that the number of digits cannot be changed when writing. Furthermore, when you
switch from OFF to ON, the decimal places is set to 0.

• Item name PIDxSP (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops are specified, the value is 0.
• Item name PIDxASP (CX only)
Specifiable tag: Control loop PID
Item names are ASP1, ASP2, ASP3, and ASP4.
If control mode is OFF or if the analog retransmission loops or loops on which alarms
are turned OFF are specified, the value is 0.
3-14
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• Item name PIDxP (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops or loops on which
proportional band cannot be set are specified, the value is 0.
• Item name PIDxI (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops or loops on which integral
time cannot be set are specified, the value is 0.

3
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• Item name PIDxD (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops or loops on which
differential time cannot be set are specified, the value is 0.
• Item name PIDxOH (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops or loops whose output
upper limit cannot be set are specified, the value is 0.
• Item name PIDxOL (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops or loops whose output
lower limit cannot be set are specified, the value is 0.
• Item name PIDxMR (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops or loops whose manual
reset cannot be set are specified, the value is 0.
• Item name PIDxPO (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops or loops whose preset
output cannot be set are specified, the value is 0.
• Item name PIDxDR (CX only)
Specifiable tag: Control loop PID
Reverse:
1
Direct:

2

If control mode is OFF or if the analog retransmission loops are specified, the value is
0.
• Item name PIDxH (CX only)
Specifiable tag: Control loop PID
If control mode is OFF or if the analog retransmission loops or loops whose relay
hysteresis cannot be set are specified, the value is 0.
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• Item name INPUT
Specifiable tag: Communication input data

Note
When writing, the real number writing value is converted to “%4E” format and sent. Therefore,
please note that there are times when the write value is not sent as-is.

• Item name Value (CX of style number S3 or later only)
Specifiable tag: Control computation constant

Note
When writing, the real number writing value is converted to “%4E” format and sent. Therefore,
please note that there are times when the write value is not sent as-is.

• Item name STATUS
Specifiable tag: COMMON
Indicates the status of the specified device (see below).
Operating normally.
The specified device does not exist.
Failed to allocate memory area.
Failed to open communications.
Communication error.

0
1
2
3
4

When the status is 3 and 4, and 0 is written, the DAQOPC server attempts to recover
the communication of the specified device.
Writing 0 when the status is 0, 1, or 2 is void.

Note
With the DX-P, if a communication errors due to a mistaken password, the server does
not recover communications even if 0 is written.

• Item name PROP
Specifiable tag: COMMON
Indicates the property read status of the specified device (see below).
The properties of the specified device have not been read.
The properties of the specified device have been read.
Performs a read operation to the specified device.

0
1
2

When 2 is written, the properties are retrieved from the specified device. Normally,
the properties are read when the DAQOPC is started. When a retrieve request for a
property value is not received, the server returns this value. In addition, the server
uses the decimal position information of the measured and computed values that are
retrieved at the start of DAQOPC. Therefore, if you change the range, the number of
loops, the PID number, and other settings on the specified device, make sure to
execute a reread.
• Item name Record
Specifiable tag: COMMON
The sampling status is shown as follows.
During sampling or sampling start
2
Sampling stopping or sampling stopped
1
In the case of a communication error, the value prior to occurrence of the error is held.
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• Item name Math
Specifiable tag: COMMON
The computation status is shown as follows.
When nonexistent
0
Computation stopped or computation stopping
1
Computation executing or computation start
2
Computation reset
3
In the case of a communication error, the value prior to occurrence of the error is held.

3
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• Item name Name
Specifiable tag: COMMON
Displays the batch name. Up to thirty-two characters can be used on the DX-P, or up
to sixteen on the CX/DX.
In the case of a communication error, the value prior to occurrence of the error is held.
No check is performed on the server side to determine whether or not the input value
is allowed.
• Item name LotNo.
Specifiable tag: COMMON
Displays the lot number.
In the case of a communication error, the value prior to occurrence of the error is held.
No check is performed on the server side to determine whether or not the input value
is allowed.
• Item name Direct
Specifiable tag: MESSAGE
Executes writing of the message set on the main unit. Enter a message number.
Set to 0 when Read.

Access path
OPC defines access path for distinguishing the COM (Component Object Model)
ports, but the DAQOPC DA Server does not use it.

Blob
OPC defines a parameter called Blob to increase the efficiency of ItemID searches,
but the DAQOPC DA Server does not use it.
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3.2.4 Data acquisition operation
DAQOPC supports the following OPC specified data reference interfaces.
• IOPCSyncIO
• IOPCASyncIO2
• IOPASyncIO(Old)
Regarding the data acquisition functions used by these interfaces, the DA server
operation is described in depth in the OPC specifications. The data acquisition operation
of the DAQOPC basically complies with the OPC specifications. The flow chart below
outlines the operation of DAQOPC.

Limits of Data Acquisition Operation
The data acquisition operation complies with the OPC specifications. However, if the
acquisition request from the client software exceeds the specifications of the
maximum number of data points of DAQOPC, the process is temporarily suspended.
Therefore, the desired response will not be obtained.

Cached data update
The cached data is scheduled in units of the update rate as follows:
1. The cached data is divided into update rate communication units (the maximum
number of data points that can be transferred each time: 10000).
2. If the data and the update rate are the same, it is scheduled once to avoid
duplication.
3. Each communication unit is scheduled as follows:
• Each communication unit maintains its update rate.
• Scheduling is dispersed so that duplication of communication units within the
same second with the same update rate is avoided as much as possible up to a
range of one minute.
• Scheduling is performed so that duplication within the same second with
communication units of other update rates is minimized.
• The communication unit of each update rate is scheduled with the start point at
each 0 s of the system time. If multiple communication units of the same update
rate exist, they are scheduled in order every 1 s with the update rate as the
maximum width.

Schedule of
1-minute data

1-minute
update data 1

1-minute
update data 2

10-second
update data 1

Schedule of
10-second data

Schedule of
2-second data

2-second
update data 1

n-second

3-18

1-minute
update data 3

10-second
update data 2

2-second
update data 1

n+1-seccond

n+2-second

n+3-second
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Data change notification
DAQOPC rules regarding the data change check for the data change notification are
given below.
• For data of which the type is VT_R8 (measured and computed values (PV)), if the
ratio of the difference between the current cached data and the new value is
greater than the deadband, cached data is updated.
• For data of which the type is VT_I2 (alarm status (ALARMx), device status
(STATUS), and property read status (PROP)), if there is a difference between the
current cached data and the new value, cached data is updated.

3
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3.2.5 Group Object Properties (IOPCGroupStateMgt)
“Groups” are provided as means by which the OPC client can efficiently access the
process data via the DA server. The OPC client is able to register arbitrary number of
items in a group, and, in general, this group is handled as a unit for process data access.
The handling of group object properties that are vender-specific is indicated below.
Group name
For the DAQOPC DA Server, if no name is specified when creating a group object, a
group object with the following name is created.
Name of the created group:
CSGroup1, CSGroup2, ..., CSGroupN
where N is an integer string.
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3.2.6 Item Properties
Item properties are property values that can be retrieved by specifying the ItemID and
property ID. The following types of data can be acquired.
• Specifying the data item PV (measurement channel, computation channel,
internal loop (CX), and external loop (CX))
ItemID is specified as follows:
Device name!measurement, computation channel, internal loop, or external loop.PV
Example:

DEVICE1!CH001.PV
DEVICE1!Loop1.PV
DEVICE1!Ext1.PV

Property ID VARIANT type Description
“Item Canonical Data Type”
1
VARTYPE
Allows retrieval of VARIANT data type of items.
“Item Access Rights”
5
VT_I4
Access level of item.
1: Read only
“Server Scan Rate”
6
VT_R4
Allows retrieval of the DX/DX-P/MV/CX scan or control rate (control loop)
in the ms order.
Example “250”
“EU Unit”
100
VT_BSTR
Allows retrieval of the engineering unit specified on the DX/DX-P/MV/CX
Space for skipped channels and loops that are turned OFF.
Example “°C”
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101

VT_BSTR

102

VT_R8

103

VT_R8

6006

VT_I2

“Item Description”
Allows retrieval of the tag strings specified on the DX/DX-P/MV/CX.
Example “Furnace 1”
“High EU”
Allows retrieval of the upper limit of the span or scale that is
specified on the DX/DX-P/MV/CX.
0 for skipped channels and loops that are turned OFF.
Example “2.0000”
“Low EU”
Allows retrieval of the lower limit of the span or scale that is
specified on the DX/DX-P/MV/CX.
0 for skipped channels and loops that are turned OFF.
Example “–2.0000”
“Decimal Point”
Allows retrieval of the number of digits to the right of the decimal
point when displaying measured values and computed values on
the DX/DX-P/MV/CX (The number of digits to the right of the decimal
point of the PV range for internal loop control with PV switching
of the CX).
0 for skipped channels and loops that are turned OFF.
Example “2”

IM 04L01B03-61E

3.2 OPC Interface Functions
• Specifying the data item ALARM (measurement channel, computation channel,
internal loop (CX), and external loop (CX))
ItemID is specified as follows:
Device name!measurement, computation channel, internal loop, or external
loop.ALARM1 to ALARM4
Example:

DEVICE1!CH001.ALARM1
DEVICE1!Loop1.ALARM1
DEVICE1!Ext1.ALARM1

3

For Measurement/Computation channels

5

VT_I4

VT_I2(2)
“Item Access Rights”
Access level of item.

6

VT_R4

1: Read only
“Server Scan Rate”
Allows retrieval of the DX/DX-P/MV/CX scan rate in the ms order.

100

VT_BSTR

Example “250”
“EU Unit”
Allows retrieval of the engineering unit specified on the DX/DX-P/MV/CX.
Space for skipped channels.
Example “°C”

6004

VT_I2

“Alarm Type”
Allows retrieval of the type of alarm specified on the DX/DX-P/MV/CX.
OFF for all skipped channels and measurement channels that are
turned OFF.
0: Alarm OFF
1: Upper limit alarm

5: Upper limit on rate-of-change alarm
6: Lower limit on rate-of-change alar

2: Lower limit alarmm
7: Delay upper limit alarm
3: Difference upper limit alarm 8: Delay lower limit alarm
4: Difference lower limit alarm
6005

VT_R8

6007

VT_I2

“Alarm Trigger”
Allows retrieval of the alarm trigger value specified on the DX/DX-P/MV/CX.
0 when alarm is OFF.
0 for skipped channels.
Example “1.583”
“Alarm Detect”
Acquires the alarm detection ON/OFF set on the CX
(For the DX, DX-P, and CX Style 1 or 2, always set to 1:ON)
0: OFF: Do not detect alarms
1: ON Detect alarms
(operates as normal alarms)
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Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items

3.2 OPC Interface Functions
For CX internal loop
Property ID VARIANT type Description
1

VARTYPE

“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)

5

VT_I4

“Item Access Rights”
Access level of item.
1: Read only

6004

“Alarm Type”

VT_I2

Allows retrieval of the type of alarm specified on the CX.
All OFF when alarms do not exist.
0:

26:

Deviation within high & low limits alarm

21: PV high-limit alarm

Alarm OFF

27:

SP high-limit alarm

22: PV low-limit alarm

28:

SP low-limit alarm

23: Deviation high-limit alarm

29:

Output high-limit alarm

24: Deviation low-limit alarm

30:

Output low-limit alarm

25: Deviation high & low limit alarm
For CX external loops
Property ID

VARIANT type

Description

1

VARTYPE

“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2

5

VT_I4

“Item Access Rights”
Access level of item.
1: Read only
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• Specifying the data item AT
ItemID is specified as follows:
Device name!measurement, computation channel, or internal loop.AT1 to AT4
Example:
Property ID
1

VARIANT type
VARTYPE

VT_I4

Description
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
“Item Access Rights”
Access level of item.
1: Read only

3

• Specifying the data item ASP
ItemID is specified as follows:
Device name!measurement, computation channel, or Loopx.PID-ASP1 to ASP4
Example:

DEVICE1!CH002.ASP1
DEVICE1!Loop3.PID2-ASP1

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
VT_I4
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
VT_BSTR
“EU Unit”
Allows retrieval of the engineering unit specified on the DX/DX-P/MV/CX.
Space for skipped channels and loops that are turned OFF.
Example “°C”
102
VT_R8
“High EU”
Allows the retrieval of the upper limit within the selectable range.
0 for skipped channels, loops that are turned OFF,
and alarms that are turned OFF.
Example “2.0000”
103
VT_R8
“Low EU”
Allows the retrieval of the lower limit within the selectable range.
0 for skipped channels, loops that are turned OFF,
and alarms that are turned OFF.
Example “–2.0000”
6006
VT_I2
“Decimal Point”
Allows retrieval of the number of digits to the right of the decimal point
when displaying alarm setpoint on the DX/DX-P/MV/CX.
If skip channels/OFF loops or control loops are set to alarm OFF,
the value is 0.
Example “2”
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5

DEVICE1!CH01.AT1
DEVICE1!Loop1.AT1

3.2 OPC Interface Functions
• Specifying the data item SP (CX)
ItemID is specified as follows:
Device name!internal loop, PID-SP, or external loop
Example:

DEVICE1!Loop2.SP
DEVICE1!Loop2.PID2-SP
DEVICE1!Ext2.SP

For Internal/External Loops
Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
5

VT_I4

6

VT_R4

VT_R8(5)
“Item Access Rights”
Access level of item.
1: Read only
“Server Scan Rate”
Allows retrieval of the CX control interval in the ms order.
Example “250”

100

VT_BSTR

“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
Space for loops that are turned OFF .
Example “°C”

101

VT_BSTR

102

VT_R8

“Item Description”
Allows retrieval of the tag strings specified on the CX.
Example “Furnace 1”
“High EU”
Allows retrieval of the SP high-limit specified on the CX.
0 for loops that are turned OFF.
Example “2.0000”

103

VT_R8

6006

VT_I2

“Low EU”
Allows retrieval of the SP low-limit specified on the CX.
0 for loops that are turned OFF.
Example “–2.0000”
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“Decimal Point”
Allows retrieval of the number of digits to the right of
the decimal point when displaying values on the CX.
(The number of digits to the right of the decimal point of the PV
range for internal loop control with PV switching of the CX)
0 for non-existing loops and loops that are turned OFF.
Example “2”
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For PID
Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items
VT_R8(5)
5
VT_I4
“Item Access Rights”
Access level of item
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
VT_BSTR
“EU Unit”

VT_R8

103

VT_R8

6006

VT_I2

Allows retrieval of the engineering unit specified on the CX
Space for loops that are turned OFF
Example “°C”
“High EU”
Allows retrieval of the SP high-limit specified on the CX
0 for loops that are turned OFF
Example “2.0000”
“Low EU”
Allows retrieval of the SP low-limit specified on the CX
0 for loops that are turned OFF
Example “–2.0000”
“Decimal Point”
Allows retrieval of the number of digits to the right of
the decimal point when displaying values on the CX
0 for loops that are turned OFF
Example “2”
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• Specifying the data item OUT (CX)
ItemID is specified as follows:
Device name!internal loop or external loop.OUT
Example:

DEVICE1!Loop2.OUT
DEVICE1!Ext02.OUT

For Internal Loops
Property ID VARIANT type Description
VARTYPE
1
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items
VT_R8(5)
VT_I4
5
“Item Access Rights”
Access level of item
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
VT_R4
6
"Server Scan Rate"
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100

VT_BSTR

101

VT_BSTR

102

VT_R8

103

VT_R8

6006

VT_I2

Allows retrieval of the CX control interval in the ms order
Example “250”
“EU Unit”
Allows retrieval of the engineering unit specified on the CX
Space for loops that are turned OFF
Example “%”
“Item Description”
Allows retrieval of the tag strings specified on the CX
Example “Furnace 1”
“High EU”
Allows the retrieval of the upper limit of the span
0 for loops that are turned OFF
Example “105.0”
“Low EU”
Allows the retrieval of the low limit of the span
0 for loops that are turned OFF
Example “–5.0”
“Decimal Point”
Allows retrieval of the number of digits to the right of
the decimal point when displaying values on the CX
0 for loops that are turned OFF
Example “1”
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For External Loops

• Specifying the data item RUN (CX)
ItemID is specified as follows:
Device name!internal loop.RUN
Example:
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DEVICE1!Loop2.RUN

Property ID
1

VARIANT type
VARTYPE

5

VT_I4

Description
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
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Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
VT_I4
“Item Access Rights”
Access level of item.
1: Read only.
6
VT_R4
“Server Scan Rate”
Allows retrieval of the CX control interval in the ms order.
Example “250”
100
VT_BSTR
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
Space for loops that are turned OFF.
Example “%”
101
VT_BSTR
“Item Description”
Allows retrieval of the tag strings specified on the CX.
Example “Furnace 1”
102
VT_R8
“High EU”
Allows the retrieval of the upper limit of the span.
0 for loops that are turned OFF.
Example “105”
103
VT_R8
“Low EU”
Allows the retrieval of the low limit of the span.
0 for loops that are turned OFF.
Example “–5”
6006
VT_I2
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
0 for loops that are turned OFF.
Example “1”

3.2 OPC Interface Functions
• Specifying the data item MODE (CX)
ItemID is specified as follows:
Device name!internal loop.MODE
Example:

DEVICE1!Loop2.MODE

Property ID
1

VARIANT type
VARTYPE

5

VT_I4

Description
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled

• Specifying the data item REMLOC (CX)
ItemID is specified as follows:
Device name!internal loop.REMLOC
Example:

DEVICE1!Loop2.REMLOC

Property ID
1

VARIANT type
VARTYPE

5

VT_I4

Description
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled

• Specifying the data item SPNO (CX)
ItemID is specified as follows:
Device name!internal loop.SPNO
Example:
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DEVICE1!Loop2.SPNO

Property ID
1

VARIANT type
VARTYPE

5

VT_I4

Description
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
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• Specifying the data item PIDNO (CX)
ItemID is specified as follows:
Device name!internal loop.PIDNO
Example:

DEVICE1!Loop2.PIDNO

Property ID
1

5

Description
“Item Canonical Data Type”

VT_I4

Allows retrieval of VARIANT data type of items.
VT_I2(2)
“Item Access Rights”
Access level of item.
1: Read only.

3
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VARIANT type
VARTYPE

• Specifying the data item PIDx.P (CX)
ItemID is specified as follows:
Device name!PID of the internal loop.P
Example:

DEVICE1!Loop2.PID3.P

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5

VT_I4

100

VT_BSTR

102

VT_R8

103

VT_R8

6006

VT_I2

“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
“%” Fixed
“High EU”
Allows the retrieval of the upper limit within the selectable range.
“999.9” Fixed
“Low EU”
Allows the retrieval of the lower limit within the selectable range.
“0.1” Fixed
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
“1” Fixed
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• Specifying the data item PIDx-I (CX)
ItemID is specified as follows:
Device name!PID of the internal loop-I
Example:

DEVICE1!Loop2.PID3-I

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
5
“Item Access Rights”
VT_I4
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100

VT_BSTR

102

VT_R8

103

VT_R8

“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
“S” Fixed
“High EU”
Allows the retrieval of the upper limit within the selectable range.
“6000” Fixed
“Low EU”
Allows the retrieval of the lower limit within the selectable range.
“0” Fixed

• Specifying the data item PIDx-D (CX)
ItemID is specified as follows:
Device name!PID of the internal loop-D
Example:

DEVICE1!Loop2.PID3-D

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
5
“Item Access Rights”
VT_I4
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
“EU Unit”
VT_BSTR
Allows retrieval of the engineering unit specified on the CX.
“S” Fixed
102
“High EU”
VT_R8
Allows the retrieval of the upper limit within the selectable range.
“6000” Fixed
103
“Low EU”
VT_R8
Allows the retrieval of the lower limit within the selectable range.
“0” Fixed
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• Specifying the data item PIDx-OH (CX)
ItemID is specified as follows:
Device name!PID of the internal loop-OH
Example:
Property ID
1

5

102

103

6006

VARIANT type Description
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
VT_I4
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
VT_BSTR
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
“%” Fixed
VT_R8
“High EU”
Allows the retrieval of the upper limit within the selectable range.
“105.0” Fixed
VT_R8
“Low EU”
Allows the retrieval of the lower limit within the selectable range.
“–5.0” Fixed
VT_I2
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
“1” Fixed

• Specifying the data item PIDx-OL (CX)
ItemID is specified as follows:
Device name!PID of the internal loop-OL
Example:

DEVICE1!Loop2.PID3-OL

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
VT_I4
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
VT_BSTR
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
“%” Fixed
102
VT_R8
“High EU”
Allows the retrieval of the upper limit within the selectable range.
“105.0” Fixed
103
VT_R8
“Low EU”
Allows the retrieval of the lower limit within the selectable range.
“–5.0” Fixed
6006
VT_I2
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
“1” Fixed
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100

DEVICE1!Loop2.PID3-OH

3.2 OPC Interface Functions
• Specifying the data item PIDx-MR (CX)
ItemID is specified as follows:
Device name!PID of the internal loop-MR
Example:

DEVICE1!Loop2.PID3-MR

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
VT_I4
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
VT_BSTR
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
“%” Fixed
102
VT_R8
“High EU”
Allows the retrieval of the upper limit within the selectable range.
“105.0” Fixed
103
VT_R8
“Low EU”
Allows the retrieval of the lower limit within the selectable range.
“–5.0” Fixed
6006
VT_I2
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
“1” Fixed

• Specifying the data item PIDx-PO (CX)
ItemID is specified as follows:
Device name!PID of the internal loop-PO
Example:

DEVICE1!Loop2.PID3-PO

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
VT_I4
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
VT_BSTR
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
“%” Fixed
102
VT_R8
“High EU”
Allows the retrieval of the upper limit within the selectable range.
“105.0” Fixed
103
VT_R8
“Low EU”
Allows the retrieval of the lower limit within the selectable range.
“–5.0” Fixed
6006
VT_I2
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
“1” Fixed
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• Specifying the data item PIDx-DR (CX)
ItemID is specified as follows:
Device name!PID of the internal loop-DR
Example:

DEVICE1!Loop2.PID3-DR

Property ID
1

VARIANT type
VARTYPE

5

VT_I4

Description
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled

3
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• Specifying the data item PIDx-H (CX)
ItemID is specified as follows:
Device name!PID of the internal loop-H
Example:

DEVICE1!Loop2.PID3-H

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
VT_I4
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
6

102

VT_BSTR

VT_R8

“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
Space for loops that are turned OFF.
Example “°C”
“High EU”
Allows the retrieval of the upper limit within the selectable
range (value of EUS100.0%).
0 for loops that are turned OFF.
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103

VT_R8

6006

VT_I2

Example “2.0000”
“Low EU”
Allows the retrieval of the lower limit within the selectable
range (value of EUS0.0%).
0 for loops that are turned OFF.
Example “–2.0000”
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
0 for loops that are turned OFF.
Example “2”
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• Specifying the data item BS1 (CX)
ItemID is specified as follows:
Device position!control loops.BS1
Example: DEVICE1!Loop2.BS1
Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
VT_I4
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
6
VT_BSTR
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
Space for loops that are turned OFF.
Example “°C”
102
VT_R8
“High EU”
Allows the retrieval of the upper limit within the selectable
range (value of EUS100.0%).
0 for loops that are turned OFF.
Example “2.0000”
103
VT_R8
“Low EU”
Allows the retrieval of the lower limit within the selectable
range (value of EUS–100.0%).
0 for loops that are turned OFF.
Example “–2.0000”
6006
VT_I2
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
0 for loops that are turned OFF.
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• Specifying the data item BS2 (CX)
ItemID is specified as follows:
Device position!control loops.BS2
Example: DEVICE01!LoopZ.BS2

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
5

VT_I4

3

VT_R8(5)
“Item Access Rights”

6

VT_BSTR

Advanced version: 3 = read/write enabled
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
Example “°C”

102

VT_R8

“High EU”
Allows the retrieval of the upper limit within the selectable
range (value of EUS100.0%).

103

VT_R8

0 for loops that are turned OFF.
Example “2.0000”
“Low EU”
Allows the retrieval of the lower limit within the selectable
range (value of EUS–100.0%).
Example “–2.0000”

6006

VT_I2

“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
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Access level of item.
Basic version: 1 = read only

3.2 OPC Interface Functions
• Specifying the data item RBS (CX)
ItemID is specified as follows:
Device position!control loops
Example: DEVICE01!LoopZ.RBS

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”

5

VT_I4

Allows retrieval of VARIANT data type of items.
VT_R8(5)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
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100

VT_BSTR

“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
Space for loops that are turned OFF.
Example “°C”

102

VT_R8

103

VT_R8

6006

VT_I2

“High EU”
Allows the retrieval of the upper limit within the selectable
range (value of EUS100.0%).
0 for loops that are turned OFF.
Example “2.0000”
“Low EU”
Allows the retrieval of the lower limit within the selectable
range (value of EUS–100.0%).
Example “–2.0000”
“Decimal Point”
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
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• Specifying the data item FL1 (CX)
ItemID is specified as follows:
Device position!control loops.FL1
Example: DEVICE01!LoopZ.FL1

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
5
“Item Access Rights”
VT_I4
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
“EU Unit”
VT_BSTR

103

VT_R8

VT_R8

Allows retrieval of the engineering unit specified on the CX.
“S” Fixed
“High EU”
Allows the retrieval of the upper limit within the selectable
range.
“120” Fixed
“Low EU”
Allows the retrieval of the lower limit within the selectable
range.
“–1” Fixed

• Specifying the data item FL1 (CX)
ItemID is specified as follows:
Device name!control loop PID-H
Example: DEVICE1!Loop2.PID3-H
Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
5
VT_I4
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
100

VT_BSTR

102

VT_R8

103

VT_R8

Advanced version: 3 = read/write enabled
“EU Unit”
Allows retrieval of the engineering unit specified on the CX.
“S” Fixed
“High EU”
Allows the retrieval of the upper limit within the selectable
range.
“120” Fixed
“Low EU”
Allows the retrieval of the lower limit within the selectable
range.
“–1” Fixed
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102

3

3.2 OPC Interface Functions
• Specifying the data item RFL (CX)
ItemID is specified as follows:
Device position!control loops.RFL
Example: DEVICE01!LoopZ.RFL

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
5
“Item Access Rights”
VT_I4
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
“EU Unit”
VT_BSTR

102

103

VT_R8

VT_R8

Allows retrieval of the engineering unit specified on the CX.
“S” Fixed
“High EU”
Allows the retrieval of the upper limit within the selectable
range.
“120” Fixed
“Low EU”
Allows the retrieval of the lower limit within the selectable
range.
“–1” Fixed

• Specifying the data item RT (CX)
ItemID is specified as follows:
Device position!control loops.RT
Example: DEVICE01!LoopZ.RT

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
“Item Access Rights”
VT_I4
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
100
“Hight EU”
VT_R8
Allows the retrieval of the upper limit within the selectable
range.
“30000” Fixed
102
“Low EU”
VT_R8
Allows the retrieval of the lower limit within the selectable
range.
“0.0001” Fixed
103
“LDecimal Point”
VT_R8
Allows the retrieval of the number of digits to the right of
the decimal point when displaying values.
Note: If the ratio setting is OFF, the value is 0. Also, the
number of digits after the decimal point is the value
held when communication starts or when property
information is acquired through PROP. Therefore,
after communication starts, if you change number of
digits after the decimal point on the instrument side,
a reload is executed through item PROP.
Example “2”
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• Specifying the data item INPUT (Communication Input Data)
ItemID is specified as follows:
Device name!communication input data.INPUT
Example: DEVICE1!CHC01.INPUT

Property ID VARIANT type Description
1
“Item Canonical Data Type”
VARTYPE
Allows retrieval of VARIANT data type of items.
VT_R8(5)
VT_I4

“Item Access Rights”

DAQOPC DA Server Functions

5

3

Access level of item.
102

VT_R8

Communication input data
3: Read and write.
“High EU”

103

VT_R8

Allows the retrieval of the upper limit that can
be input.
“Low EU”
Allows the retrieval of the lower limit that can
be input.

• Specifying the data item Value
ItemID is specified as follows:
Device name!!W αα.Value
Example: DEVICE1!Wαα.Value
Property ID
1
OPC_PROP_CDT

VARIANT type Description
VARTYPE
“Data Type”
Allows retrieval of VARIANT data type of items.
VT_R8(5)
5
VT_I4
“Item Access Rights”
OPC_PROP_RIGHTS
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
102
VT_R8
“Hight EU”
OPC_PROP_HIEU
Allows the retrieval of the upper limit within the
selectable range (9.9999E29).
“9.9999E29” Fixed
103
VT_R8
“Low EU”
OPC_PROP_LOEU
Allows the retrieval of the lower limit within the
selectable range (–9.9999E29).
“–9.9999E29” Fixed

• Specifying the data item STATUS (COMMON)
ItemID is specified as follows:
Device name!COMMON.STATUS
Example: DEVICE1!COMMON.STATUS
Property ID VARIANT type Description
1
“Item Canonical Data Type”
VARTYPE
Allows retrieval of VARIANT data type of items.
VT_I2(2)
5
“Item Access Rights”
VT_I4
Access level of item.
3: Read and write.
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• Specifying the data item PROP (COMMON)
ItemID is specified as follows:
Device name!COMMON.PROP
Example: DEVICE1!COMMON.PROP

Property ID VARIANT type Description
1
VARTYPE
“Item Canonical Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
5
VT_I4
“Item Access Rights”
Access level of item.
3: Read and write.

• Specifying the data item Record (COMMON)
ItemID is specified as follows:
Device name!COMMON.Record
Example: DEVICE1!COMMON.Record
Property ID
1
OPC_PROP_CDT

VARIANT type Description
VARTYPE(2)

5
VT_I4(3)
OPC_PROP_RIGHTS

“Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled

• Specifying the data item Math (COMMON)
ItemID is specified as follows:
Device name!COMMON.Math
Example: DEVICE1!COMMON.Math
Property ID
1
OPC_PROP_CDT

VARIANT type Description
VARTYPE(2)
“Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
5
VT_I4(3)
“Item Access Rights”
OPC_PROP_RIGHTS
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
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• Specifying the data item Name
ItemID is specified as follows:
Device name!Batch.Name
Example: DEVICE1!Batch.Name

Property ID
1
OPC_PROP_CDT

VARIANT type Description
VARTYPE(2)
“Data Type”

3
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5
VT_I4(3)
OPC_PROP_RIGHTS

Allows retrieval of VARIANT data type of items.
VT_BSTR(8)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled

• Specifying the data item Lot.No
ItemID is specified as follows:
Device name!Batch.LotNo
Example: DEVICE1!Batch.LotNo
Property ID
1
OPC_PROP_CDT

VARIANT type Description
VARTYPE(2)
“Data Type”

5

VT_I4(3)

OPC_PROP_RIGHTS

102

Allows retrieval of VARIANT data type of items.
VT_I4(3)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled

VT_R8(5)

OPC_PROP_HIEU

“Hight EU”
Allows the retrieval of the upper limit within the
selectable range.
DX/CX: “9999” Fixed

103

VT_R8(5)

OPC_PROP_LOEU

DX-P:
“99999999” Fixed
“Low EU”
Allows the retrieval of the lower limit within the
selectable range.
“0” Fixed

• Specifying the data item Direct
ItemID is specified as follows:
Device name!Batch.Direct
Example: DEVICE1!Batch.Direct
Property ID
1

VARIANT type Description
VARTYPE(2)

OPC_PROP_CDT
5
OPC_PROP_RIGHTS
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“Data Type”
Allows retrieval of VARIANT data type of items.
VT_I2(2)
“Item Access Rights”
Access level of item.
Basic version: 1 = read only
Advanced version: 3 = read/write enabled
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• Specifying the tag number (measurement channel)
ItemID is specified as follows:
Device name!measurement channel
Example:

DEVICE1!CH001

Cannot be registered in a group.
Property ID VARIANT type Description
101
VT_BSTR
“Item Description”
Allows retrieval of the tag strings specified on the
DX/DX-PMV/CX.
Example “Furnace 1”
6003
VT_BSTR
“Input Range”
Allows the retrieval of range strings of measurement
channels.
Example “TC, TypeK”

• Specifying the tag number (computation channel)
ItemID is specified as follows:
Device name!computation channel
Example:

DEVICE1!CH031

Cannot be registered in a group.
Property ID VARIANT type Description
101
VT_BSTR
“Item Description”
Allows retrieval of the tag strings specified on
the DX/DX-P/MV/CX.
Example “Furnace 1”

• Specifying the tag number (communication input data)
There are no item properties that can be retrieved.
Cannot be registered in a group.
• Specifying the tag number (Control computation constant)
There are no item properties that can be retrieved.
Cannot be registered in a group.
• Specifying the tag number (COMMON)
There are no item properties that can be retrieved.
Cannot be registered in a group.
• Specifying the tag number (Batch)
There are no item properties that can be retrieved.
Only existing devices can be registered to groups.
• Specifying the tag number (Message)
There are no item properties that can be retrieved.
Only existing devices can be registered to groups.
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• Specifying the loop number
ItemID is specified as follows:
Device name!loop number
Example:

DEVICE1!Loop2

Cannot be registered in a group.
Property ID VARIANT type
101
VT_BSTR

Description
“Item Description”
Allows the retrieval of the tags and tag comment strings

Example “Furnace 1, Loop 1”

• Specifying the external loop
ItemID is specified as follows:
Device name!external loop
Example:

DEVICE1!EXT02

Cannot be registered in a group.
Property ID VARIANT type Description
101
VT_BSTR
“Item Description”
Allows the retrieval of the tags and tag comment strings
specified on the CX.
The format is “tag, tag comment” (up to 17 characters).
Space for loops that are turned OFF.
Example “Funace 1”
6001
VT_BSTR
“Model”
Allows the retrieval of the model of the external loop
“?????” for non-existing loops.
Space for loops that are turned OFF.
Example “Utxxx”

• Specifying the device
ItemID is specified as follows:
Device name
Example:

DEVICE1

Cannot be registered in a group.
Property ID VARIANT type Description
“Model”
6001
VT_BSTR
Allows the retrieval of the DX/DX-P/MV/CX
model on the DX/DX-P/MV/CX.
Example “DX120”
“Login Level”
6002
VT_I2
Allows the retrieval of the login level to the
DX/DX-P/MV/CX.
1: Administrator level
2: User level
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specified on the CX.
The format is “tag, tag comment” (up to 17 characters).

3
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3.2.7 Locale ID (LCID)
The locale ID (LCID) is a language identifier that is used when the OPC server returns
values as strings. It is used in alarms, status, and other parameters that include
engineering units.
In general, the DAQOPC ignores the locale ID.
The unit and tag strings of the DX/DX-P/MV/CX are passed without any modification.
For error strings ( IOPCServer::GetErrorString, IOPCCommon::GetErrorString), the
DAQOPC Server only supports the locale or the Windows system. However, all error
strings that are defined by the OPC are returned in English (Windows system errors are
returned in the local language).

3.2.8 Structures Defined by the OPC
The DAQOPC handles the vendor-specific section of the structures that are defined by
the OPC specifications as follows:
Item property structure (OPCITEMATTRIBUTES)
• Engineering Unit
The engineering unit is the range information of the item ID.
Server status structure (OPCSERVERSTATUS)
• Bandwidth
On the DAQOPC, the bandwidth is set to the number of ItemIDs that are registered
in the cache update.
• VenderInfo
“Yokogawa Electric Corporation” is set on the DAQOPC server.
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3.2.9 Support for OPC Optional Specifications
The OPC optional functions that DAQOPC supports are described below.
Browsing (retrieves a list of ItemIDs in the server)
• Hierarchy
IOPCBrowseServerAddressSpace is an interface used to retrieve a list of tags. There
are two methods available for viewing the server-side list, FLAT or HIERARCHICAL.
For the DAQOPC, use the HIERARCHICAL method specifying the device name, tag
number, and data item in that order.
• ItemID retrieval through GetItemID
The following string is returned for GetItemID.
• When a device name is specified
Device name
Example: Device1
(Cannot be used in IOPCItemMgt::AddItems)
• When a tag number is specified
Device name!tag number
Example: Device1!ch01
(Cannot be used in IOPCItemMgt::AddItems)
• When a data item is specified
Device!tag number.data item
Example: Device1!ch01.PV
(Can be used in IOPCItemMgt::AddItems)

3
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Note
The DAOPC browse information shown is that from the connected devices. Browse
information is automatically obtained at the timing at which the connection to the device could
be made successfully (including communications recovery time).

• BrowseOPCItemIDs filter
If you specify OPC_FLAT for the filter type, the operation is the same as when both
OPC_BRANCH and OPC_LEAF are specified. Sorting is not performed on the list,
and there is no limit in the number of data points that can be entered in the list.
Therefore, the larger the number of tag numbers, more memory space is consumed.
In such case, you can use the following types of filters to suppress the amount of
memory that is consumed at any given time.
[szFilterCriteria]:
[dwAccessRightsFilter]:

DAQOPC ignores this parameter.
DAQOPC supports this parameter.

• BrowseAccessPaths
Since AccessPaths is not used, this is not supported.
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Error Codes
The error codes that DAQOPC specifies are shown below.
Number

3-46

Message

Description

0xC0049001 “Fail to allocate memory.”

Failed to allocate memory area.

0xC0049002 “Fail to read configuration file.”

Failed to load the communication setup file.

0xC0049003 “Selected device doesn’t exist.”

A nonexistent device is specified by the
Configurator.

0xC0049004 “Fail to open device.”

Failed communications at startup.

0xC0049005 “Communication error.”

A communication error occurred.

0xC0049006 “Irrelevant value.”

Invalid value was input for communication
input data.

0xC0049007 “Fail to get time stamp from PC.”

Failed to get the time stamp from the PC.

0xC0049008 “Selected item doesn’t exist.”

Non-existent item is being specified.
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